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Getting Familiar with Microsoft Word 2010 for 

Windows 

Microsoft Word is a word processing software package. You can use it to type letters, 

reports, and other documents. This tutorial teaches Microsoft Word 2010 basics. 

Although this tutorial was created for the computer novice, because Microsoft Word 

2010 is so different from previous versions of Microsoft Word, even experienced users 

may find it useful. 

This lesson will introduce you to the Word window. You use this window to interact with 

Word. To begin this lesson, open Microsoft Word 2010. The Microsoft Word window 

appears and your screen looks similar to the one shown here.  

 

Note: Your screen will probably not look exactly like the screen shown. In Word 2010, 

how a window displays depends on the size of your window, the size of your monitor, 

and the resolution to which your monitor is set. Resolution determines how much 

information your computer monitor can display. If you use a low resolution, less 

information fits on your screen, but the size of your text and images are larger. If you use 

a high resolution, more information fits on your screen, but the size of the text and 

images are smaller. Also, Word 2010, Windows Vista, and Windows XP have settings 

that allow you to change the color and style of your windows. 

 

http://www.baycongroup.com/word2007/01_word2007.html
http://www.baycongroup.com/word2007/01_word2007.html
http://www.baycongroup.com/word2007/01_word2007.html
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The Microsoft Office File Button 

In the upper-left corner of the Word 2010 window is the Microsoft File button. When you 

click the button, a drop-down menu appears. You can use the File tab to: Save, Save As, 

Open, Close, and perform many other tasks. 

 

The Quick Access Toolbar 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access 

toolbar provides you with access to commands you frequently use. By default Save, 

Undo, and Redo appear on the Quick Access toolbar. You can use Save to save your file, 

Undo to rollback an action you have taken, and Redo to reapply an action you have rolled 

back. 

 

The Title Bar 

Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the 

document on which you are currently working. Word names the first new document you 

open Document1. As you open additional new documents, Word names them 

sequentially. When you save your document, you assign the document a new name. 

Save… Redo… Undo, …More Options 
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The Ribbon 

You use commands to tell Microsoft Word what to do. In Microsoft Word 2010, you use 

the Ribbon to issue commands. The Ribbon is located near the top of the screen, below 

the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab 

displays several related command groups. Within each group are related command 

buttons. You click buttons to issue commands or to access menus and dialog boxes. You 

may also find a dialog box launcher in the bottom-right corner of a group. Clicking the 

dialog box launcher gives you access to additional commands via a dialog box. 

 

The Ruler : The ruler is found below the Ribbon. 

 

You can use the ruler to change the format of your document quickly. If your ruler is not 

visible, follow the steps listed here: 
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1. Click the View tab to choose it.  

2. Click the check box next to Ruler in the Show/Hide group. The ruler appears 

below the Ribbon.  

The Text Area  

Just below the ruler is a large area called the text area. You type your document in the 

text area. The blinking vertical line in the upper-left corner of the text area is the cursor. 

It marks the insertion point. As you type, your text displays at the cursor location. The 

horizontal line next to the cursor marks the end of the document. 

 

The Vertical and Horizontal and Vertical Scroll Bars  

The vertical and horizontal scroll bars enable you to move up, down, and across your 

window simply by dragging the icon located on the scroll bar. The vertical scroll bar is 

located along the right side of the screen. The horizontal scroll bar is located just above 

the status bar. To move up and down your document, click and drag the vertical scroll bar 

up and down. To move back and forth across your document, click and drag the 

horizontal scroll bar back and forth. You won't see a horizontal scroll bar if the width of 

your document fits on your screen. 

This is the text area. 

 

    

           Vertical Scroll Bar  

 

 

 

 

Horizontal Scroll Bar  

http://www.baycongroup.com/word2007/01_word2007.html
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The Status Bar  

The Status bar appears at the very bottom of your window and provides such information 

as the current page and the number of words in your document. You can change what 

displays on the Status bar by right-clicking on the Status bar and selecting the options 

you want from the Customize Status Bar menu. You click a menu item to select it. You 

click it again to deselect it. A check mark next to an item means it is selected. 

 

 

 

 

 

 

 

 

 

 

 

Status Bar 

http://www.baycongroup.com/word2007/01_word2007.html
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� Understanding Document Views  

In Word 2010, you can display your document in one of five views: Draft, Web Layout, 

Print Layout, Full Screen Reading, or Online Layout.  

Draft View  

Draft view is the most frequently used view. You use Draft view to quickly edit 

your document.  

Web Layout  

Web Layout view enables you to see your document as it would appear in a 

browser such as Internet Explorer.  

Print Layout  

The Print Layout view shows the document as it will look when it is printed.  

Full Screen Reading Layout  

Reading Layout view formats your screen to make reading your document more 

comfortable.  

Outline View  

Outline view displays the document in outline form. You can display headings 

without the text. If you move a heading, the accompanying text moves with it.  

You should use Draft view for these lessons. Before moving ahead, make sure you are in 

Draft view:  

1. Click the View tab.  

2. Click Draft in the Document Views group. When the Draft option is selected it 

appears in a contrasting color.  

Click:   During the lessons that follow, you will be asked to "click" items and to 

choose tabs. When asked to click: 

1. Point to the item.  

2. Press your left mouse button once.  

If you are asked to double-click an item:  

1. Point to the item.  

2. Quickly press your left mouse button twice.  

http://www.baycongroup.com/word2007/01_word2007.html
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If you are asked to right-click: 

1. Point to the item.  

2. Press your right mouse button.  

If you are asked to choose a tab, click the tab.  

Understanding Nonprinting Characters  

Certain characters, called nonprinting characters, do not print and will not appear in your 

printed document but do affect your document layout. You can elect to see these 

characters on the screen as you type or you can elect to have them remain invisible. This 

table describes most of them: 

Character Denotes 

 A tab  

   . A space 

   ¶ The end of a paragraph 

 
Hidden text 

To view nonprinting characters: 

1. Choose the Home tab.  

2. Click the Show/Hide button in the Paragraph group. The Show/Hide button 

appears in a contrasting color, when it is selected.  

 

 

 

 

 

 

 

 

 

 

 In Word 2010 display the File tab of the ribbon and then click Options. 

 Click Display at the left side of the dialog box.  

 In the Always Show These Formatting Marks On the Screen section, select the 

characters you want Word to display. 

 Click on OK. 
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Creating New Documents 
Exercise 1 

 
Once you open Word 2010, you have actually started a new document.   

Please note…you see a blank page and a blinking cursor. (Figure 1) 

Figure 1:  Microsoft Word interface. 
 
 

At this point, you can just start by entering text.  After you create a new document, you 

should save it so you can use or modify it later.  You may need several sessions in Word 

to complete final versions of lengthy or complex documents.  You can also print draft or 

final copies of the documents you create in Word.   

 

When you type text into a Word document, each character appears to the left of the 

blinking insertion point in the document window.  The text you enter into a document can 

include letters, spaces numbers and symbols.  As you type, the insertion point moves 

across the screen from right to left. 

Go ahead, and type in…. The quick brown fox jumps over the lazy dog. 

Figure 6: Typing text in a Word document. 

 



 10 

Using Word Wrap 
 

If you continued to add to this sentence, eventually you would reach the end of the line.  

Go ahead, and continue to type more words.  Please do not ever touch the Enter key on 

the keyboard.   

 

Notice that when you reached the end of the first line, the text you were typing 

automatically wrapped around to the next line.  It was unnecessary for you to actually 

press the Enter key, as you would have to on a typewriter.  Word automatically fills each 

line with as many words as will fit.  You only need to press the Enter key to end a 

paragraph or line shorter then the length of a full line. 

 

Highlighting  
 

To highlight means to actually drag your mouse pointer across the text, causing it to 

appear in a different color.  You will need to know how to highlight to perform many of 

the functions that we will cover later. 

 

Select with the Mouse  

1. Position the I-Beam in front of the first letter of your sentence.  Click the mouse    

            button once, so that the blinking insertion point is present. 

2. Click on the left mouse button, as you hold the mouse button down, drag the 

mouse over the entire sentence.  Then let go of the mouse button. 

             3. Notice now, that your sentence appears in a different color.  This is   

            called highlighting. 

             4.        Click anywhere outside the highlighted area to remove the highlighting.  

Select with the Shift and Arrow Keys  

            1. Position the I-Beam in front of the first letter of your text.  Click the mouse button     

            once, so that the blinking insertion point is present. 

2. Hold down the Shift key on the keyboard. 

3. As you hold the Shift key, press the right arrow key.  This will highlight one letter    

            at a time. 

4.         Press the down arrow key until the first paragraph is highlighted.  

5.         Click anywhere outside the highlighted area to remove the highlighting.  
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Exercise 2:  The Arrow Keys & Execute Commands with    

                    Keyboard Shortcuts 

Keyboard Movement:  

Certain keys on the keyboard move the insertion point.  The arrow keys, located 

at the right side of the keyboard, move the  insertion point in the direction of the 

arrow.  Other commands, listed below, require you to hold down one key, while 

pressing another.  For example: CTRL+END, require that you hold down the 

CTRL key while simultaneously pressing the END key. 

 

To move the insertion point.... Press...... 

One character to the left or right Left Arrow or Right Arrow 

One word left or right CTRL+Left Arrow or 

CTRL+Right Arrow 

One line up or down Up or Down Arrow 

One paragraph up or down CTRL+Up Arrow or  

CTRL+Down Arrow 

One screenful up or down Page Up or Page Down 

To left or right end of current document Home or End 

To first or last character of document CTRL+Home or CTRL+ End 
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Basic Shortcut Keys for Navigating Through Documents 

New Ctrl + N Creates a new blank document 

Open Ctrl + O Opens a saved document 

Save Ctrl + S Saves the current document 

Print Ctrl + P Prints the current page 

 

Undo Ctrl + Z Cancels the last change to the document 

Repeat Ctrl + Y Repeats the last command 

Copy Ctrl + C Copies the selected text to the clipboard 

Paste Ctrl + V Pastes the cut or copied selection 

Cut Ctrl + X Removes the selection and places it on the clipboard 

Find Ctrl + F Finds text within the current document 

 

Help F1 Opens Word’s Help center 

Save As F12 Saves the current document with a different name 

Arrow Keys Moves the cursor one place in the respective direction 

Ctrl + Left Arrow Moves the cursor one word to the left 

Ctrl + Right Arrow Moves the cursor one word to the right 

Ctrl + Down Arrow Moves the cursor to the top of the next paragraph 

Ctrl + Up Arrow Moves the cursor to the top of the previous paragraph 

 

Page Down Displays the next screen 

Ctrl + Page Down Moves the cursor to the top of the next page 

Ctrl + Alt + Page Down Moves the cursor to the bottom of the window 

Page Up Displays the previous screen 

Ctrl + Page Up Moves the cursor to the top of the previous page 

Ctrl + Alt + Page Up Moves the cursor to the top of the window 

 

End Moves to the end of the current line 

Ctrl + End Moves the cursor to the end of the document 

Home Moves to the beginning of the current line 

Ctrl + Home Moves the cursor to the beginning of the document 

 

Ctrl + G Opens the go to tab in the find and replace dialog box 

Ctrl + F Opens the find tab in the find and replace dialog box 

Ctrl + H Opens the replace tab in the find and replace dialog box 

 For additional shortcut keys, you can visit: http://support.microsoft.com/?kbid=290938 

or visit www.about.com and type word processing for other helpful information. 

 

 

http://support.microsoft.com/?kbid=290938
http://www.about.com/
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Exercise 3:                Saving Your Work 

 

Until we save our document that we have created as a file on a disk, 

the document exists only in the computer‟s temporary memory.  If the 

computer is intentionally, or unintentionally turned off, the 

computer‟s temporary memory is cleared, and the document is erased. 

We can avoid losing any document by Saving it.   

 

  Word will automatically insert a „default‟ filename.  This default is 

always the first phrase in the document.  You can change the filename 

to anything you wish.  Word can handle long filenames up to 255 

characters.  These filenames can include uppercase and lowercase 

letters, numbers and even space.  They cannot contain the characters 

< > : * | \ “ ? and /       In the File Name box, type a filename. 

  

Word will also „default‟ to a specific folder, or location where the 

document will be saved.  Here, it is “My Documents”.  If you want to 

store the document in a different folder, jump drive or in a floppy 

disk, Click the arrow to the right of the Save In box.  Use this drop 

down list to navigate to the folder or drive in which you  want the 

document to be saved in.  Double-Click that folder or drive, to display 

its name in the Save In box. 

1. Click Exit…which you find in the bottom left corner. 
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3. You are prompted: "Do you want to save changes to Document1?" To save your 

changes, click Yes. Otherwise, click No. If you click Yes, the Save As dialog box 

appears.  

 

 

 

 

 

 

 

 

4. Move to the correct folder.  

5. Name your file by typing Intro to Word 2010.doc in the File Name field.  

6. Click Save. Word saves your file in the “My Documents” folder. 
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Opening Existing Documents          

Exercise 4 

Document previously stored on your disk can be brought up on the screen to be 

revised or viewed by using the Open command.  Chose Open from the File menu.   

The Open dialog box displays the names of the files on your disk in the File Name 

box. 

 

 

Try This: 

 

1. Click on the File button in upper-left 

corner.  This displays the Open dialog 

box. 

 Listed, are some Word documents           

          that have been created.   

 

2. To open one of these documents,          

          you can: 

a.   Highlight the document you wish to    

      view, then click on Open on  the        

      right. 

b. Double-click the document you 

wish to view.   

 

Remember…when you click Open…it looks at the last place you saved or opened 

a file from.  In MS Word, the default place it looks is in the documents folder, 

so…if you want to open from your jump drive, you must select…my computer 

and that specific jump drive. 
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Print Previewing Prior to Printing   

Exercise 5 
 

You can preview your printing during the printing process to ensure appropriate 

page layout.   

 

1.  Click on the File button icon.   

 

This will display your document to the right of the screen with a multitude of setting 

options.  Don‟t get overwhelmed with all of the new setting options! Let‟s keep it 

simple! 

 

If you decide to CANCEL your printing, click on the Home Tab..  
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Printing Documents                        

Exercise 6 
 

After you create a new document, you can print it to review a hard copy.  You 

can print a document using menu commands or the print button in the Standard 

Toolbar.  When you click the button on the Standard Toolbar, you automatically 

specify to print a single copy of the document using the current print settings.   

 

You can also use the File, Print command to adjust your current print settings.   

For instance, you can specify to print multiple copies of a document, of to print 

only a portion of your document, such as a single page or paragraph.   

 

Try This: 

 

1. Click on File Button, then… click on Print.   

Before we go any further, let‟s look at the Printing options. 

 

They include: specifying a printer, a print range, and the number of copies to print 

and much more.  If you have access to more than one printer, you should verify 

that the correct printer is selected before printing your document.   
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Changing the Font                   

Exercise 7 

 

A font is a collection of letters, numbers, symbols, and punctuation you can create 

with a specific typeface, in all sizes and styles.  Some of the most common fonts 

are Roman, Courier, Times Roman, Helvetica, and Arial.   

 

Font sizes are measured in points.  Point size is the vertical measurement of a 

character.  One inch equals 72 points.  The most common point sizes are 10 and 

12 point. 

 

Try this; 

 

1. If your name is not currently on your monitor, go ahead and type it. 

2. Highlight your name.  

3.       Click the right corner indicator on the Font Menu Bar.  This displays the   

          Font Dialog Box.  It is here that you can view different font styles, sizes,  

          colors, and effects. 

4. Under the Font style, scroll down, and highlight a different font style.  Click   

          on OK when you have made your decision.  

The ribbon toolbar has some shortcuts to make it easier to change the size, shape, 

and style of your font.  From here, you can Bold, Italicize, Underline and so much 

more.  You can also change the point size, and the type of font you are typing in.   

 

NOTE:   

It is important to realize there may be a 

difference in the command you give, depending 

on WHEN you give it.  Let me explain.  If at the 

beginning of my document, I decide to type in 

16 point, Times New Roman font.  This 

decision will remain as I continue to type, and 

as long as I don‟t change it.   

 

If I, half way through the document, decide to 

start typing in 12 point, my font will change 

size, and remain that way, throughout the rest 

of the document.   
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If I, however, go back and highlight a specific phrase, line or word, and change its 

size, it will change only that part that I have highlighted.   

 

This should be practiced, a few times, before it will be fully understood. 

 

Line Spacing 

Exercise 8 

 
Word is pre-set to use single spacing.  The line spacing can be easily changed to 1.5 

or double spacing.  The new line spacing effects the entire paragraph that contains 

the insertion point or the paragraphs that are selected. 

 

Try This: 

 

1. Type your name, address and phone number as four different lines.  It 

should look like this:  

   Twinsburg Library 

   10050 Ravenna Rd 

   Twinsburg, OH 44087 

   330.425.4268 

 

2. Highlight you name and address. 

 

3. Click on the Paragraph icon or on      

           the Paragraph‟s button right  

           corner to reveal the Paragraph  

         dialog box.  

 

4. There is an option in this dialog box to 

change the spacing.  It is labeled Line 

Spacing.  Click on the small triangle 

next to the words Line Spacing, and 

choose double.   

 

5. Click on OK. 

 

You can change line spacing for an entire 

document by specifying the spacing you desire before you begin typing anything.  

Or, you can change the line spacing by highlighting a specific paragraph (as you 

just did) and changing only it.   

 

*Make sure the Before and After Spacing options shows:  0 pt  
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Cut, Copy, and Paste  

Exercise 9 

 

To copy text, means exactly that, to make a copy of it. 

 

To cut text, also means what it says, in that it actually cuts the text from your 

document. 

 

To paste text means to deposit the text that you have either cut or copied, to 

another location in your document, or to another document entirely. 

 

Let‟s Try This:    

 

1. Highlight your name only.  Click on the 

copy icon in the toolbar.  This creates an invisible 

copy of your name.  The computer is now 

waiting for you to tell it where you want this 

copy.  

 

 

2. Hit the enter key a few times, to move 

your cursor further down your page.  Now click on the paste icon in the toolbar.  

This should past a second copy of your name on you document.  (You can 

actually paste your name as many times as you want to.) 

 

3. Now, highlight you original address. Click on the cut icon in the toolbar.  

This actually cuts the original text (your address) from the document.  Click on a 

different area on your document, possibly after one other copy of your name.   

 

4. Click on the paste button in the same area of buttons.  This should have 

“cut” your address from your original name, and pasted it to where you 

currently are in the document. 
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Spelling and Grammar Check 

Exercise 10 

1. From the Review ribbon tab, in the Proofing group, click ABC 

SPELLING & GRAMMAR 

                                               OR 
Press [F7]  

The Spelling and Grammar dialog box appears. 

NOTES: 

The Spelling and Grammar dialog box appears only if Word detects spelling or 

grammar errors. 

The [F7] key can be used from any command tab.  

 

2. To exit the Spelling and Grammar dialog box, click CANCEL 

Correcting Grammar 

When Grammar Check finds a sentence that appears to have an extra space and/or 

improper grammar, the possible error will be underlined with a wavy green line. You can 

correct mistakes through the Quick menu or through a dialog box. If an error has no clear 

solution, Word displays the grammatical rule being violated.  

A red line indicates possible misspellings.  If it is spelled correctly, you can always add 

the word to its dictionary so it doesn’t keep coming up as a misspelled word. 

Word 2010 quickly fixes hundreds of common typos and spelling errors on the fly with 

the AutoCorrect feature. There’s nothing to using AutoCorrect; it happens automatically. 

Beyond spelling, AutoCorrect fixes some common punctuation.                                                                       

*I don’t use this feature…I would rather make the changes myself…but…that’s your 

choice. 


